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Overview 
This document contains the workflows for creating typical sections and typical section 
layout sheets. This workflow is intended for use with any MDT road project requiring a 
model, such as reconstruction and rehabilitation projects. 

Process Provenance 

• Date of development: 3/28/2024 

• Revision date: N/A 

• Application/Tool(s): Autodesk Civil 3D 

• Version(s): 13.4.2455.0 Civil 3D 2022.2.6  

• Environment(s): MDT Civil 3D State Kit r2022 v1.24 

• Author: MDT Road Design Workflow Subcommittee 

 

Statement of Need 
Workflows specific to typical sections were not covered in the Civil 3D production 
training classes. For that reason, the Road Design Workflow Subcommittee identified 
the need for thorough documentation covering the topic. 

Disclaimer: Because the State Kit is continuously being updated and improved, the 
styles and layers in this documentation may vary from what is in the current version of 
the State Kit. 

 

References 
203 – Civil 3D Plan Production Training 

Surfacing Calculation Spreadsheet 

mailto:cmurphy@mt.gov;%20rbarbula@mt.gov
https://www.mdt.mt.gov/other/webdata/external/cadd/designcalc/Surfacing.xltm
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Process Description and Examples 
Section I. File Setup 

 
1. Create a new file using the design-start.dwt template. Save it as 

[UPN#]RDTYP001.dwg (for example, 9555000RDTYP001.dwg) in the RD 
directory of the project on BIM 360. Use CTRL+S or navigate to the C3D icon in 
the top left and save the file. 

  
 
2. Set the Annotation Scale to 1” = 10’. 
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3. Set the Working folder to the project's Project Files folder and set the Data 
Shortcuts project folder if necessary. Then create a data reference to the 
corridor(s) within the file. 
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Section II. Create Sample Lines 
 

1. In the Home tab, click Create Sample Lines from the Profile & Section Views 
panel. 

 
 
2. Click on the alignment OR press Enter and select from the list.

 
 

 
  Popup with list of alignments when Enter key is pressed. 
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3. For the Sample Line Group, set the following, then select OK: 
Name:  

[UPN]RDTYP 
Sample line style:  

MDT-Sample Line 
Sample line label style: 

MDT-Section Station 
Data Source [Code Set] Style:  

MDT-Typical 
Section layer: 

C-XSEC-MISC 
 

NOTE: If there are multiple corridors (sources), all corridors can be selected and 
the styles and layers can be changed once to have changes apply to all the 
corridors. To do this, select the first corridor, press and hold the Shift key, then 
select the last corridor to select all sources. Then select anywhere in the Style 
column (except for the header) and change the Code Set Style to MDT-Typical. 
Repeat for the Section layer.
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4. In the Sample Line Tools, set the sample line name to the following by using the 
property fields within the Name Template button: 

TYP. NO. <[Next Counter]> - <[Sample Line Raw Station]> 

 
 

 
 
5. Ensure that the sample lines are set to be created via the At a Station method. 
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6. Select stations with full width typical sections. Do not pick a section where the 
corridor is transitioning to the next section. When specifying a station along the 
baseline, type the station without the "+" separator. Otherwise, a sample line will 
not be created. 

 
 
7. Set the left and right swath widths to 50 ft. Large surfacing widths may require 

increased swath widths. The width only needs to reach the hinge point of the 
surfacing section. 

 
 
8. Repeat Steps 6-7 to create sample lines as needed for the remaining typical 

sections. When complete, press Enter to close out of the Sample Line Tools to 
exit the command. 
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Section III. Layouts and Typical Border Setup 

Procedure – Create Layout 

1. Create a new layout using the Road Layouts within the MDT Sheets tab of the 
MDT Tool Palette. 
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2. Select the RD-Typical layout. 

 
 
3. Select the newly added RD-Typical layout. 
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Procedure – Create Viewport 

1. While in the RD-Typical layout, set the active layer to GS-VPRT, then type the 
command VPORTS and press Enter. Accept the defaults (shown below) and 
select OK. 

 
 

2. Select the corners of the border sheet as shown below: 
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NOTE: Because of the default setup, the corridor will be centered within the 
viewport. The typicals will need to be drawn a sufficient distance from anything 
else within the model space to avoid having any unwanted objects, lines, or text 
displayed within the typical section in paper space. 

 
3. Double click within the viewport and pan (click on the scroll wheel and move the 

mouse) to a location away from the corridor. 
 
4. Return to the paper space by double clicking outside the extents of the viewport 

border. In the paper space, select the viewport border (turn on selection cycling 
[Command: SELECTIONCYCLING, variable <2>] to aid in selecting) and use the 
Properties palette set the both the Annotation scale and the Standard scale of 
the viewport to 1"=10'. 

Selection Cycling icon on bottom bar: 
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Procedure – Create Borders 

1. In paper space, set the active layer to X-WRKG-0001 and draw a rectangle 
around the viewport either using the RECTANG command or selecting the 
Rectangle tool from the Drawing tools in the Home ribbon tab.  
 

2. Draw a horizontal line (Command: L for line or PL for polyline) on top of the 
middle horizontal border line. Ensure object snapping is on so that the line snaps 
to the midpoint of the rectangle. 
 

3. Select both the rectangle and line and type CHSPACE to transfer them into the 
model space. 

 
 
4. Return to the model space via the Model tab and find the border created in the 

previous steps. 
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Procedure – Insert Border Title and Table Blocks 

1. In the model space, open the blocks palette by typing BLOCKSPALETTE or by 
selecting the Insert tab and selecting the insert dropdown of the Block panel and 
selecting Blocks from Libraries.  
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2. In the Blocks Palette, select the Libraries tab and double click the RD-
Typicals.dwg library. 
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3. Within the library, select the T-TablesQtyStaLabel block so that it is attached to 
the cursor and ready to be inserted into the drawing. Using the midpoint snap, 
select the midpoint of the upper horizontal line of the border as the insertion 
point.  
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4. Repeat the process above for the second typical section, except snap to the 
midpoint of the middle horizontal line.
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5. Select the T-TableCutFill block from the blocks palette and attach it to where the 
middle horizontal line intersects the left side of the border.
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6. Select the border lines and blocks and Copy [Command: CO] the shapes 
diagonally until there are as many typical borders as the number of needed 
sheets. 

 
NOTE: Copying diagonally ensures that no more than two section view frames 
overlap. Overlapping section views can cause issues when adjusting dimensions 
on the typical sections. The issues arise when the view frame needs to be 
adjusted vertically to better position the section view within the sheet border. 
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An example setup for five to six typical sections:

 
7. Delete the default MDT-TMP layout from the drawing to clear up space by right 

clicking the layout and selecting Delete. 
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Procedure – Copy Layouts 

1. Copy the RD-Typical layout to create more layout sheets. Right click the RD-
Typical layout and select Move or Copy… from the list.

 
 

2. In the Move or Copy dialog, select (move to end), and check the Create a copy 
box. Then select OK. 
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3. In the copied layout (RD-Typical (2)), double click within the viewport and type 
OSNAPCOORD and change the variable to <0>.  

NOTE: Because this process pertains to a system variable and not a file, it only 
needs to be completed once. It may also need to be completed each time after 
updating the State Kit.  

4. While in the viewport, select the dropdown next to Extents from within the 
Navigate 2D panel in the View tab and select Window. The command ZOOM 
can also be used. Type or select W for window within the command. 
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5. With endpoint snaps turned on, select the upper left and lower right corners of 
the rectangle border.  

 
 

6. Double click outside of the viewport to return to paper space. 
 

7. Repeat steps 1-6 as necessary for the remaining borders. 
 

8. Once complete, lock the viewports in each layout to avoid any accidental 
changing of the viewport scale while switching between the model and paper 
space. Select the viewport and select the viewport lock button in the Quick 
Access toolbar on the bottom of the screen.
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Procedure – Edit Table Blocks 

1. In the model space, select the table blocks and explode them by typing X, then 
pressing Enter.  

 
 

2. Double click the cells within the tables to edit the text. If a new line must be 
added to the station ranges, select a row of the table, right click, and select 
Insert Row Below or select it from the contextual tab for the table in the ribbon.

 
NOTE: A macro for calculating for the typical section surfacing quantities in Civil 
3D does not exist, so the quantities must be calculated by the designer and 
manually entered into the tables. The surfacing calculation spreadsheet on 
MDT's web page is intended to assist designers in calculating the quantities for 
pavement sections. 
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Section IV. Create Section Views 
 

1. In the Profile & Section View panel of the Home tab, select Create Section 
View. 

 
 

2. In the General section of the Create Section View wizard, set the following: 

Section view name:  
TYP. NO. 1 [Then change for each section] 

Sample line:  
Change for each section  

Section view style:  
MDT-Typical or 
MDT-Typical Special* 

*To be used if special borrow less than two feet is included in the surfacing 
section. 
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3. Accept the defaults for the Offset and Elevation Range sections. In the Section 
Display Options, set the following:  

Label Set:   
 _MDT-No Labels  
Style: 

  MDT-Typical 

 
 

4. Set the Data Bands to _MDT-No Bands, then select Create Section View.  
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5. Select the midpoint of the middle horizontal line as the starting point for the 
section view.

 
 
The section view will be drawn, like shown below: 
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6. IF NEEDED: To move the section up so that the bottom dimensions will not 
overlap with the quantities table, select the view frame border, then select the 
square grip on the midpoint. Move the square grip up so that the section linework 
is roughly centered between the top of the Quantities table and the bottom of the 
title. 

 
 

7. Repeat steps 1-6 as necessary for the remaining typical sections. Remember to 
select the sample line associated with the next typical section.

 

  



Montana Department of Transportation - Typical Sections in Autodesk 

 

Add Dimensions and End Conditions PAGE 29 | 34 
 

Section V. Add Dimensions and End Conditions 
 

1. In the Blocks palette, select the T-Dimensions block from the RD-Typicals block 
library.   

 
 

2. Insert the block on the centerline of the roadway using the endpoint snap.
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3. Set the active layer to X-WRKG-0002. Draw a line to connect the end of the 
surfacing inslope to the bottom of the CAC on both the left and right side of the 
section. 

 
 

4. Select the newly drawn lines and change the lineweight to 0.005” using the 
Properties palette. Doing so will match the line weights that are set within the 
code set style. 
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5. Insert the appropriate end conditions from the block library. The insertion point is 
where the bottom of the CAC meets the line drawn in Step 3. 

Shown below: T-EndCondition-LT-Cut for the left side and T-EndCondition-
RT-CutVDitch for the right side. 

 

 
6. Explode (X) the dimensions block and drag and snap the dimensions to the 

appropriate points. If multiple dimensions are tied to the same point, they can all 
be selected at once and moved simultaneously. 
 
For sections that have additional lanes, Copy the dimensions from the block.  
 
If a dimension needs a line break with the font (i.e., the Travel Lane or SHLD 
designation), double click within the dimension. At the end of the number, type \X 
to insert the text line break. 
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NOTE: Dimensions may need to be edited as necessary to display the desired 
values and eliminate discrepancies. For example, the full width dimension for 
aggregate treatment and tack may show the true model width of 68.1’, rather 
than 68.0’. To edit the dimensions, double click within the dimension contents to 
overwrite the numerical values. 

 
 

7. Use the command DIMBREAK OR select the Break button from the Dimensions 
panel in the Annotate tab in the ribbon to break the dimensions surrounding the 
full width dimensions. Type M and press Enter OR select Multiple from the 
command line to break multiple dimensions at once. Select the dimensions left 
and right of centerline to be broken, press Enter, then select the full width 
dimensions as the breaking elements. Repeat as necessary until there are 
breaks surrounding all full width dimensions. 
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8. Adjust the hatch to match the thickness of the pavement section by stretching 
straight up from the corner points. If the dimension arrow is displayed behind the 
hatch, select the dimension, and use the Display Order (Right click>Display 
Order) to bring the dimension to front.   

 
 

9. If the typicals do not fit within the sheet border limits, the scale of either the 
viewport or the border may need to be adjusted, or both. 
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Section VI. Completed Example 
Example of a completed typical section in model space:  

 
Example of a plotted typical section sheet: 
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